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1 GUIDELINES FOR DATA/INFORMATION IN THE 
GIS DATABASE 

1.1 GIS Manual 

This section only refers to the important aspects that were considered in the period of 
training. The other details concerning the utilisation of Arc View are explained in the 
manuals “Using ArcView GIS” in detail. 

1.1.1 Introduction 

ArcView, is a powerful, easy-to-use tool that allows the access of geographic 
information by computer. ArcView gives you the power to visualise, explore, query 
and analyse data spatially. 
ArcView is produced by the Environmental Systems Research Institute (ESRI), the 
makers of ARC/INFO, the leading geographic information system (GIS) software in 
the world.  

1.1.2 Working with Project 

A project is the file that stores work done with ArcView. A project typically contains 
all the view, tables, charts, layouts, and scripts that are necessary to use a particular 
ArcView application. This enables the storage of the work in one convenient place. 
The next time the need to work on this application arises, simply open this project file 
in ArcView to access all the components required. Project files have an [.apr] 
extension. 
 

a. Creating a project 

1. Start ArcView and from the File menu, choose New Project 

2. ArcView creates a new project called Untitled and opens the project window.  
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1.1.3 Management of a Project 

a. Opening an existing project 

1. From the File menu, choose Open Project. 

 
 

2. ArcView displays the Open Project dialog box where you specify the name 
and location of the project you want to open. 

b. Copying a project 
1. From the File menu, choose Save Project As. ArcView displays a dialog box 

in which you give the active project a different name and save it. 

c. Renaming or deleting a project 
1. Close the project. In a multi-user environment, confirm that all users have 

closed the project. 
2. Use your system's file management application, desktop editing technique or 

the appropriate rename or delete command to work with the ArcView [.apr] 
file. If you are renaming the project, the new name can be up to eight 
characters long but can't contain spaces. 

1.1.4 Creating and Using Maps 

a. What’s a view and theme  

A view is an interactive map that lets you display, explore, query and analyse 
geographic data in ArcView. Views are saved in the ArcView project you are 
currently working with. A view defines the geographic data that will be used and how 
it will be displayed, but it doesn't contain the geographic data files themselves. 
Instead, a view references these source data files. This means that a view is dynamic, 
because it reflects the current status of the source data. If the source data changes, a 
view that uses this data will automatically reflect the change the next time the view is 
drawn.  
A view is actually a collection of themes. A theme represents a distinct set of 
geographic features in a particular geographic data source. For example, a view 
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showing a country might have one theme representing cities, one theme representing 
roads, one representing rivers, etc. 
 

b. Creating a new view and adding a theme to a view 

1. On the Project window, click the Views button and then press the New button. 
A new, empty view will appear in your project. 

 

 
 

2. Add themes to the view for each spatial data source you want to display. You 
can also add themes based on tabular data such as street addresses or XY 
coordinates. Click on the add button. 

 

 
 

3. ArcView displays the Add theme dialog box where you specify the name and 
location of the theme you want to add. 
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4. Click check boxes of the theme names to be drawn into your view. These 
check boxes let you toggle themes on and off in the view. 

 
 

 
 

1.1.5 Laying out and Printing Maps 

a. Creating a layout 

A layout is a map that lets you display views, charts, tables, imported graphics, and 
graphic primitives. The layout is used to prepare these graphics for output from 
ArcView. The layout defines what data will be used for output and how they will be 
displayed. The layout can be dynamic because it allows you to make specific graphics 
live. When a graphic is live, it reflects the current status of the data. For example, if 
the data in a view changes, the layout automatically reflects the change. 
 

1. From the file menu select Layout. 
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2. Select the paper size, orientation and then Click on the ok button. 
 

 
 

3. Add legend, scale bar, title and graphic, and when you are finally satisfied 
with your layout you can send it to a printer. 

 

 
 
b. Exporting a layout 
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You can export a layout to a file in any of a number of supported output formats. 
ArcView exports to the following formats:  

• Placeable Windows Metafile 
• Windows Metafile 
• Windows Bitmap 
• Encapsulated PostScript - New 
• Encapsulated PostScript - Old 
• Adobe Illustrator 
• CGM Binary 
• CGM Character 
• CGM Clear Text 
• JPEG 

 
1. Select the layout you want to export 
2. From the file menu select Export. 

 
 

 
 

3. ArcView displays the Export dialog box where you specify the name and 
location of the layout to export and select a file format from the List Files of 
Type. 
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1.1.6 Working with Tabular Data 

a. What’s is a table? 

A table lets you work with data from a tabular data source in ArcView. You can bring 
data from almost any tabular data source in your organisation into ArcView as tables. 
Then you can add data from these tables to maps, and symbolise, query and analyse 
this data geographically.  

An ArcView table references the tabular data source it represents, but doesn't contain 
the tabular data itself. This means that tables are dynamic, because they reflect the 
current status of the source data they are based on. If the source data changes, a table 
based on this data will automatically reflect the change the next time you open the 
project containing this table. You can also choose Refresh from the Table menu to 
refresh the table at any time to see the current state of your source data. The 
definitions of tables you add to ArcView are saved in the project file you are 
currently working on. 
 

You can create new tables in ArcView and type data values into them directly. You 
can also edit some tables, depending on the type of tabular data source they represent 
and whether you have write permission. See editing the values in a table. 
 
You can add dBASE, INFO, tab or a comma, and delimited text files into ArcView as 
tables. These data sources can contain any data that you wish to work with in 
ArcView. For example, these tables might contain additional information about the 
features displayed on a view.  
 
From ArcView, you can connect to a database server, such as Oracle or Sybase, and 
run an SQL query to retrieve records from the server as a table. ArcView stores the 
definition of the SQL query used, not the records themselves. See Connecting to a 
Database to create a table. 

b. Management of a Table 
b.1 Opening a theme’s table 

1. Open the view containing the theme. 
2. Click on the theme to make it active and Click the Open Theme Table button 

in the View button bar. 
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3. When you open a theme's table, it will appear in the list of tables in the Project 
window in which case it can also be opened using the Open button on the 
Project window. 

 
 

 

 

 

 

 

 

b.2 Adding a table into a project 
1. Select the table icon in the project windows and click the “Add” button. 
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2. ArcView displays the [Add Table] dialog box where you specify the name, 
type and location of the file to add a dBASE, INFO or delimited text file as a 
table in your project. 

 

 
 

b.3 Creating a new table 

1. With the Tables icon selected, click the New button at the top of the Project 
window. 
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2. Enter a name and a disk location for the dBASE file that ArcView will create 
to store the source data for the table. ArcView creates a new table and its 
name will appear in the list of tables in the project. ArcView names new 
tables in numerical order: Table1, Table2, Table3, etc.   

b.4 Editing a table 

1. Open the table you want to edit. 
2. From the Table menu, choose Start Editing. If you have write access to the 

data source, you will be allowed to edit the table. You can add or delete fields 
and records and edit the values in the table. 

 

 
 
 

 

 

 

 

b.5 Closing a table 

1. From the File menu, choose Close, or click the close control on the table's 
window. 

b.6 Deleting a table 
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Click once on the table in the list in the Project window and choose Delete from the 
Project menu. You will be prompted to confirm deleting the table. Deleting a table 
removes it from the project, but does not affect the tabular data source that the table is 
based on. 

b.7 Exporting a table 

1. Open the table you want to export. 
2. From the File menu, choose [Export] 

 

 
  

3. ArcView displays the [Export Table] dialog box where you specify the export 
format and then click the [OK] button. 

 

 
 

c. Join tables 

You can join a table to the active table based on the values of a common field found 
in both tables. Join establishes a one-to-one or many-to-one relationship between the 
destination table (the active table) and the source table (the table you are joining into 
the active table). Typically, the source table contains descriptive attributes of features 
that you wish to join into a theme's table so that you can symbolise, label, query and 
analyse the features in the theme using the data from your source table. 
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c.1 Joining two tables 

1. Open the tables you wish to join. 
2. For example, joining cadastral information with the attribute of cadastral 

boundary table. 
3. Make the source table active (cadastral information). Click the name of the 

common field you wish to use, in this case (PID). 
 

 
 

4. Make the destination table (attribute of cadastral boundary). Click the name of 
the common field you wish to use (PID). 

 

 
 
 

 

5. From the Table menu choose Join, or click the Join button. Now you have a 
table of cadastral boundary with cadastral information. 

 

Destination table Source table 

Join 
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Tables are joined based on a field that is found in both tables. The name of the field 
does not have to be the same in both tables, but the data type has to be the same. You 
can join; 

• Numbers to numbers 
• Strings to strings 
• Booleans to Booleans 
• Dates to dates. 

Any field can be chosen as the basis for a join, not just ones that uniquely identify 
geographic features.  

c.2 Why is the join option dimmed out when I try to join tables 

1. The problem may be because the source table already contains a join. For 
example, if you join table A to table B and then try to join table B to table C, 
the join option will appear dimmed out. To see if your source table already 
contains a join, make it active and look at the Remove All Joins option in the 
Table menu. If Remove All Joins is not dimmed out, your source table does 
contain one or more joins. 

 
To perform a join in this situation you can either choose Remove All Joins to 
remove any existing join(s) from your source table and then perform the join 
or export the source table into a new table, add that table into your project, 
then do the join. The latter option is more useful than the first because it 
ensures that all the data in your original table is joined to the destination table. 
 
To perform a join in this situation you can either choose Remove All Joins to 
remove any existing join(s) from your source table and then perform the join 
or export the source table into a new table, add that table into your project, 
then do the join. The latter option is more useful than the first because it 
ensures that all the data in your original table is joined to the destination table. 
 
The destination table (the table that is active when you choose Join) can 
contain existing joins. 

2. Join will also be dimmed out if the data types of the fields that you are joining 
are different, for example, trying to join tables on a zip code field that is under 
type number in one table and type string in another. The string field is left 
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justified while the number field is right justified. To resolve this issue, add a 
field to one of the tables that is of the appropriate type and use the calculator 
to add zip codes from the original field. 

3. Joins are also not possible if the source table is in edit mode. 

c.3 Editing joined data 

When editing a joined table, you can only edit the fields in the destination table. Edits 
to the fields from source tables must be performed directly on those tables. You can 
then use Refresh from the Table menu to show the changes in the joined table. 

c.4 How are joins saved 

When you save a project containing a join, ArcView saves the definition of the join 
rather than saving the joined data itself. The next time you open the project, ArcView 
rejoins any joined tables by reading their files from disk or re-executing the SQL 
queries they are based on. In this way, any changes to the source or destination tables 
that have taken place since they were last joined are automatically included in the 
project, and reflected in any views, tables, charts or layouts based on the joined data. 
 
Because joining tables has no effect on their physical files on disk, you don't need to 
have write permission to files to be able to join them in ArcView.  
 
If you want to make a new table on disk to permanently store the joined data, you 
choose Export from the Table menu. You would do this, for example, if you want to 
use the table in another application. 
 
To remove joined fields from a table you are working on, choose Remove All Joins 
from the Table menu. 
 
d. Spatial joins 

If you join two theme attribute tables together using their Shape field as the common 
field, ArcView automatically bases the join on the spatial relationship between the 
features in the two themes.  

d.1 Performing a spatial join 

This can be carried out if for example you have a land use theme and district 
boundary theme, and if you want to know the land use type per each district. 

1. From the view, open the attribute tables of the themes you wish to join. In this 
case land use themes and district boundary themes. 

2. Make the source table active (District boundary); this is the table you wish to 
join to the other table. Click the Shape field’s name. 
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3. Make the destination table active (Land use); this is the table you wish to 
receive the values of the source table. Click the Shape field's name. 

 

 
 

4. From the Table menu choose Join, or click the Join button. The source table is 
joined to the destination table. The source table is closed automatically. 

 
A spatial join is similar to an attribute join; however it is based on the spatial 
relationship between the features in the two themes. For each feature 
represented in the destination table, ArcView determines if any of the 
following spatial relationships exist with any feature represented in the source 
table, and if so, that feature's record from the source table is joined into the 
destination table: 

 
Shapes Point Line Polygon 
Point Nearest Nearest Inside 
Line Nearest Part of Inside 
Polygon n/a n/a Inside 
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When the spatial join is based on the 'nearest' relationship (i.e., neither of the 
two themes involved contains polygons and one of them contains points), 
ArcView adds a Distance field to the destination table. This field is 
automatically calculated by ArcView and contains the distance to the nearest 
feature represented in the source table for each feature represented in the 
destination table. The distance is calculated in the view’s map units. 

 
When the spatial join is based on the 'part of' relationship (i.e., both themes 
involved contain line features), the line features represented in the destination 
table have to be substrings of the line features represented in the source table 
to satisfy the spatial join. In other words, the lines in one theme are part of the 
lines in the other theme.  

 

e. Link two tables 

Join establishes a one-to-one or many-to-one relationship between the destination 
table and the source table. However in some situations you may want to establish a 
one-to-many relationship between the destination table and the source table.  
 
An example of a one-to-many relationship is a table on type of land use and the table 
on land use in the entire district. One type of land use may be predominant (many) in 
the entire district. You may want to select a specific type of land use in the entire 
district. 
 

1. From the view, open the attribute tables of the themes you wish to join. In this 
case type of land use themes and land use of the district themes. 

2. Make the source table active (land use of the district); this is the table you 
wish to link to the other table (type of land use). Click the field’s name to link 
(type). 

3. From the [Table] menu select [Link] 
 

 
 

4. Select open space in the type of land use table, and all open space will be 
selected for the land use of the district. 
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f. Calculating features 

f.1 Calculating area of polygon themes 

1. Open the attribute tables of the themes you wish to calculate the area. In this 
example Cadastral boundary themes. 

 

 
 

2. Make the source table active and from the [Table] menu select [Start Editing]. 
The table will enable to make changes. 
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3. From the [Edit] menu, select [Add Fields]. Input the name, type, width and 
decimal places of the fields, and then click the [OK] button.  

 

 
 

4.  Now you have a table with the new fields to calculate the area of the 
polygons. 

 

 
 

5. From the [Field] menu, select [Calculate]. 
 

 
 

6. In the [Field Calculator] dialog box, type [Shape].ReturnArea and then click 
on the [OK] button. 
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7. ArcView calculates the area of each polygon in the table. To save the changes 
in the table select [Stop editing] from the [Table] menu. 

 
   
f.2 Calculating the length of line themes 

1. Same as calculating the area, open the attribute tables of the themes you wish 
to calculate the area. In this example District boundary themes. 

2. In the [Field Calculator] dialog box, type [Shape].Returnlength and then click 
on the [OK] button. 

3. ArcView calculates the length of the shape in the table. In the case of the 
polygons, it calculates the length of perimeters, and the length of the line for 
polyline. 

 

g. Getting the X and Y coordinate from point themes 

1. Follow the same step to edit and add fields. 
2. In this example the X and Y coordinates are calculated for the location of 

industries . 
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3. Open the table of industries themes  
4. Add new fields to calculate the X and Y coordinates. 
5. Select the new fields X. 
6. In the [Field Calculator] dialog box, type [Shape].GetX and then click on the 

[OK] button. 
7. ArcView calculates the X coordinate of the point shape in the table. 
8. Select the new fields Y. 
9. In the [Field Calculator] dialog box, type [Shape].GetY and then click on the 

[OK] button. 
10. ArcView calculates the Y coordinate of the point shape in the table. You can 

get a table for each industry with the X and Y coordinate. 
 

 
 

1.1.7 GeoProcessing 

GeoProcessing is a way to create new data based on themes in your view. In most 
cases you will alter the geometric properties of the features in a dataset while 
controlling some aspects of how its attribute data is handled. 
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a. Starting GeoProcessing 

1. From the [File] menu select [Extensions]. 
 

 
 

2. In the [Extensions] dialog box select [Geoprocessing]. 
 

 
 

3. Now you can select [Geoprocessing Wizard] from the [View] menu. 
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4. This will prompt the Geoprocessing dialog box. 
 

 
 

b. Intersecting two themes 

This process is similar to clipping a theme, except for the fact that it preserves only 
those features falling within the spatial extent common to both themes. The features 
of the input theme are intersected or sliced by the intersect theme. The attribute data 
from both themes are included in the new theme's attribute table.  
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The Intersect process computes the geometric intersection of the two themes and adds 
it to your view as a new theme. The input theme can be a line or polygon theme. The 
overlay theme must be a polygon theme. The overlay theme’s features will split the 
input theme. Any features in the input theme that are not overlaid by features in the 
overlay theme will not be added to the new theme. The output shapefile’s features 
will be of the same type as the input theme features. When intersecting features of the 
input theme with the polygons of the overlay theme, the attribute tables are also 
updated. The attribute table for the output shapefile includes the attributes from the 
input and overlay theme. 
 
Use the Intersect process when you want to integrate two spatial data sets while 
preserving only those features falling within the spatial extent common to both 
themes. For example you have land use themes and district boundary themes, and you 
will want to know the exact area of land use type by each district you had to intersect 
those two themes. 
 

1. Open the themes to intersect 
2. In the [Geoprocessing] dialog box select [Intersect two themes]. 
3. Select the input theme, the overlay theme and the location of the output file, 

and then click on the [Finish] button.  
 

 
  

4. ArcView will process the intersection and create the new theme. 
 
c. Merging features 

Use the Merge process when you want to create a new theme containing two or more 
adjacent themes of the same shapefile type. For example, you may want to merge or 
append highway data delivered as a series of tiles. Merge allows you to append the 
data while maintaining the attributes contained in whichever shapefile you select. 
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Select themes to merge: Choose two or more themes that are of the same geometry 
type. The Finish button will not be enabled until you have selected two or more 
themes of the same type. You can use the Control and Shift keys in conjunction with 
your mouse click to select more than one or a range of themes. 
 
Use Fields from: Choose the theme that contains the attributes you want to use in the 
theme that will result from this merge operation. If each of the other chosen themes 
have the same fields, then all cells in the attribute table of the merged theme will be 
populated. If any of the other input themes have additional fields, that data will not be 
included. If any of the other input themes are missing the fields, then no data will be 
added to those fields for the features of the selected theme. 
 
Note: The dropdown list of available themes will not be activated until two or more 
themes of the same shapefile type have been selected for merging. To select more 
than one theme, you need to hold down the Shift key. 
Specify the output file: Browse for or enter the shapefile name that will be used to 
store the results of the merge operation. 
 

d. Clipping features 

Use the clip operation when you want to cut out a piece of one theme using another 
theme as a "cookie cutter". For example, you may want to select a county boundary 
from your counties theme to extract the roads from your roads theme to create a new 
theme containing a smaller number of roads. 

For this process you can use the Clip option in the GeoProcessing Wizard, but 
remember to first select the county polygons defining the clip area before starting the 
Clip wizard. Enter the roads data as the input theme and the county boundaries as the 
polygon overlay theme. The clipping theme is used as the "cookie cutter" to clip the 
roads. Then, check the "Use selected feature only" box to use the selected features as 
your clipping area. Then specify the output theme name or use the default name, 
clip1.shp.  
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e. Union two themes 

Use the Union process when you want to produce a new theme containing the 
features and attributes of two polygon themes. Let’s look at using Union to provide 
the basis for performing an erosion analysis of soils during a flood. Some 
combinations of slope and soil type represent high risk for erosion, and knowing 
where these conditions are enables risk assessment of crops. For instance, rocky or 
sandy soil on a relatively steep slope could represent flash-flooding dangers to either 
crop or grazing agricultural activities during rainstorms. 
 

 
 
f. Assigning data by location 

Use Assign data by location when you want to use a spatial relationship to join data 
from the attribute table of one theme to the attribute table of another theme. 
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Depending on the type of data you have, the join will be one of three types of spatial 
relationships: 'nearest', 'inside', or 'part of'. 
 
Nearest: If you're assigning data from a point theme to another point theme OR 
you're assigning data from a point theme to a line theme, a 'Distance' field is 
automatically added to the theme you're assigning data to, along with any other data 
in that theme. This 'Distance' field contains the distance to the nearest feature. 
 
Inside: If you're assigning data from a polygon theme to a point, line, or polygon 
theme, the data will be joined to the point, line, or polygon that is contained in each 
of the polygons. 
 
Part of: If you're assigning data from a line theme to another line theme, data will be 
assigned from lines that are 'part of' (a sub-set of) the lines you're assigning data to.  
 

 
 

1.1.8 Management of a Table with Microsoft  Excel 

To manage ArcView data into the Microsoft  Excel, you can export data from 
ArcView to Excel and make a report. 

1. For example, when using the data of land use by district to make a report: 
Area of type of land use by each district. 

2. Export the ArcView table data into DBF format. 
3. Open the exported file in Excel. Specify the location and change the [File 

type] into dBase files. 
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4. Now you have a data file in Excel to manage as you want. 
 

 
 

5. From the [Data] menu select [Pivot table report and pivot chart report] 
 

 
 

6. In the [PivotTable and PivotChart Wizard] step 1 dialog box, select the type 
of the data to analyse. In this case select the [Microsoft Excel list or database] 
and click on the [Next] button. 
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7. In this step select the range of the data. Excel automatically selects the entire 
database. Click on the [Next] button.  

 

 
 

8. In this step select the location of the pivot table. You can select the entire 
worksheet or a new worksheet. Click the [Finish] button. 

 

 
 

9. Excel creates the pivot table to manage the database and create any type of 
table. 
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10.  Drop in the row fields Type (Land use type), in the column fields name 
(District name) and in the center the area_m2, to calculate the area of each 
type of land use by district.  

 

 
 

11. Finally you can obtain the following table. 
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12. Format the number and the border to print. (For more details about pivot table 
please refer to Excel help files.) 

 

1.1.9 Spatial analysis 

a. Creating themes from external data 

In this example we will use the data of air pollution concentration. The database 
contains X, Y coordinates and the concentration in each point is calculated using 
another application (air.dbf). 

1. Add the external database. 
 

 
 

2. From the [View] menu, select [AddEvent Theme…] to convert the database to 
themes file. 
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3. In the [Add Event Theme] dialog box, select the new table, X field (the 
column that contains the X coordinate) and Y field (the column that contains 
the Y coordinate). Click the [OK] button. 

 

 
 

4. ArcView creates the new point theme. Activate the new theme in the view. 

 
 

5. In this step we will create the map of air pollution concentration at each point. 
From the [Surface] menu, select [Interpolate Grid]. 
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6. In the [Output Grid Specification], select as follows. For more details you can 
change each value in this step. 

 

 
 

7. In the [Interpolate Surface] dialog box, select the method and indicate the Z 
value Field. (In this case select the Conc that contains the concentration 
value.) 

 

 
 

8. ArcView creates a new theme with a concentration value that you can display 
as follows.  
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1.1.10 3D analysis 

a. Creating a TIN (Triangulated Irregular Network) from contour lines 

   1. Open the line theme contains elevation value you wish to create the TIN. 

 
 

   2. From the [Surface] menu, select the [Create TIN from Features]. 
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   3. Input the Height source, Input as, and then click the [OK] button. 

 
   4. Input the output file name, and then click the [OK] botton. 

 
   5. Now you have a TIN grid image in the view. 
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b. Creating a Slope image using TIN 

1. From the [Surface] menu, select the [Derive Slope]. 

 
2. Input the Output Grid Extent and Output Grid Cell Size. Number of Rows and 

Number of Columns are calculated automatically, and then click the [OK] 
button. 

 
   3. Now you have a Slope image in the view.  
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c. Creating an Aspect image using TIN 

1. From the [Surface] menu, select the [Derive Aspect]. 

 
2. Input the Output Grid Extent and Output Grid Cell Size. Number of Rows and 

Number of Columns are calculated automatically, and then click the [OK] 
button. 

 
   3. Now you have an Aspect image in the view. 
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d. Creating a Hillshade image using TIN 

   1. From the [Surface] menu, select the [Compute Hillshade]. 

 
   2. Input the Azimuth and Altitude, and then click the [OK]. 

 
3. Input the Output Grid Extent and Output Grid Cell Size. Number of Rows and 

Number of Columns are calculated automatically, and then click the [OK] 
button. 

 
   4. Now you have a Hillshade image in the view. 
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1.2 Database Management 

1.2.1 Hardware 

For hardware the following have been installed: 2 Workstations, 1 plotter  
2 Workstations 
9 Dell Precision Workstation 620 
9 Pentium  III 500Mhz XEON Processors 
9 RAM Memory 1,024MB 
9 Monitor 21’ 
9 4 SCSI HD 8.5GB 
9 FDD 1.44 
9 CD-RW 
9 CD ROM 
9 Keyboard/Mouse 

 
1 Plotter 
9 HP DesignJet 2500CP 
9 Memory 36MB 

 

1.2.2 Software 

The following software were selected:  
 
2 Workstations 
9 Windows  NT  Ver. 4.0 
9 Arc View  3.2 
9 Arc View  Spatial Analyst 
9 Arc View  3D Analyst 
9 Arc View  Network Analyst 
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HP DesignJet
2500CP

Hub

Workstation 1

DELL Precision 620

Workstation 2

DELL Precision 610

HDD
8.5GB

FDD 1.44MB CD-ROM

CD-RW

HDD
8.5GB

FDD 1.44MB CD-ROM

CD-RW
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1.2.3 Using a computer 

All the computers mentioned previously are connected by a LAN (Local Area 
Network), to ensure compatibility between resources and increased productivity. The 
next figure shows the configuration of the LAN, which is of the type “Star” with 8 
port hubs that allow the ability to increase the number of workstations as required. 
The LAN is of a Client/Server mode where the Server operates by Windows NT 4.0, 
and the Workstations with Windows 98. For the effective use of this operating 
system, that is to also strictly control the users and the security of stored data, and for 
the effective management of valuable GIS data, the following are defined:  

• LAN Administrator: Is the person authorised by the institution to manage 
the whole LAN and be responsible for the operation:  

• Account of users of the workstation. 
• Grants permission for the sharing of files and folders. 
• Data and hardware security 
• Data backup 
• Hardware configuration 

 
• Users: people authorised by the administrator to use the workstations and 

have access to the data.  
 
a. To use the computer follow the steps below. 

1. Turn on the Server (Administrator) 
a. Turn on the UPS connected to the Server 
b. Turn on the Server and wait until Windows  NT starts. 
c. Make sure that the Hub is turned on.  

2. After the Server is started, turn on the workstations (Users)  
a. To start the workstations, make sure that the Server is ready. 
b. To start the session in the LAN, the users should be registered with the 

Server and authorised by the administrator.  
c. Input the user name and the password and then start the session. 

 

1.2.4 Administering Windows NT Server (Administrators) 

Windows NT is frequently marketed as an operating system that requires little or no 
system administration, a concept that is more based on theory than on reality. Well 
designed system administration tools can go a long way toward making Windows NT 
systems management easy and painless under normal circumstances and some of the 
Windows NT tools come reasonably close to this objective. Realistically, however, 
you can expect the unexpected to occur all too frequently.  
 
System administrators are distinguished from ordinary users, power users, and 
operators in that they know what to do when things go wrong. While all these classes 
of users are comfortable using the system under normal circumstances, only system 
administrators have to know what to do when things are anything but normal. This 
doesn't mean you have to know the solution instantly for every problem you 
encounter. Sometimes you will, but more often what you bring to the situation is a 
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strategy for figuring out what has gone wrong and the tools for fixing it once you 
have done so. 

 
Successful system administrators are continually aware that computers are used by 
people and organisations and that their management has to be carried out within this 
social context. System administration often involves a tension between authority and 
responsibility on the one hand and service and cooperation on the other. The extremes 
seem easier to maintain than any middle ground; fascistic dictators who rule "their 
network" with an iron hand, unhindered by the needs of users, find their opposite in 
the harried system managers who jump from one user request to the next, in continual 
interrupt mode. The trick is to find a balance between being accessible to users and 
their needs, and sometimes even their mere wants, while maintaining authority and 
sticking to the policies put into place for the overall system welfare. The goal is to 
provide an environment where users can get what they need to do done, in as easy 
and efficient a manner as possible, given the constraints of security, other users' 
needs, the inherent capabilities of the system, and the realities and constraints of the 
human community in which all of them are located. 

a. The system administrator’s job 

• Installing and configuring computer systems and networks, updating them as 
necessary, and keeping them running properly on a day-to-day basis.  

• Managing users and user accounts, including both the computer-related 
aspects of creating and maintaining user accounts and systems, and 
responding to user requests, questions, and problems.  

• Taking care of the peripheral devices attached to the various computer 
systems (printers, tape drives, non-interruptible power supplies) as well as 
adding or removing them as needed.  

• Overseeing regular system backups, which can range from performing 
backups to designing and implementing a backup plan to be carried out by 
others.  

• Ensuring that the systems and networks for which you are responsible are 
secure and that valuable or sensitive data is protected from undesired access.  

• Monitoring system and network activity in order to quickly detect any 
problems related to system security, performance, or general functioning that 
may arise, and then responding appropriately to any anomaly that may be 
detected.  

 

1.2.5 Windows NT Server Network 

A LAN is a group of PCs that have been connected to enable communication and the 
sharing of resources. The LAN is based on a windows NT Server (“Client/Server” 
type) that constantly ensures security and consistency in connection, that is relatively 
easy to put into practice and to maintain.  
 
Windows NT Server requires at least one “File Server” in the LAN, in which the 
Windows NT operating system is executed. However, the clients or the PC’s 
connected to the LAN can adopt a different type of operating system, e.g. Windows 
NT Workstation, Windows 95, OS/2, Macintosh, Unix, etc.  
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From the point of view of an administrator, the LAN enables the centralised 
administration of the account of the users and the problems related with security.  
 
The following are some of the characteristics of a secure Operating System: 
• Limits access to the domain to specific users.  
• Limits access to the domain to certain number of hours.  
• Limits access, for user or for group, to resources of LAN like files, folders and 

printers.  
• Limits that control type has witch users for files and directory.  
• To clarify any action taken in different files or directory or the type of access that 

was granted or even attempted.  
 
It is, however, important to bear in mind that the security of the operating system 
works like a padlock. A padlock purchased from a hardware store can only provide 
the protection required when used appropriately. Likewise, the security options 
provided by an operating system becomes ineffective if the administrator has no 
detailed security plan.  
 

1.2.6 Connection of Workstations 

This section focuses on the use of Windows 98 as the Workstation of the network.  

a. Installation of the network components 

To set up a PC using Windows 98 as a Workstation, the establishment of the 
following net components is necessary.  

• Network adapters or Network card  
• Network clients  
• Network protocols  
• Network services  

a.1 Network card 

The hardware physically connects the PC to the network, and is, therefore, 
indispensable. The installation of a network card is relatively easy with the 
Plug-and-Play functions in Windows 98 that recognises a new device in the system. 
Once installed the card verifies the following.  

1. Select [Network Neighborhood] then click the right button of the mouse and 
choose [Properties].  
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2. Verify in the following screen that the network card is installed.  
 

 
a.2 Network clients 

If in the [Network] dialog box, any [Network Client] type is not installed, follow the 
steps shown below. 

1. In the [Network] dialog box, click [Add].  
2. In the [Select Network Component Type] dialog box, select [Client] and click 

on [Add].  

 
3. In the [Select Network Client] dialog box, choose [Microsoft] for the 

manufacturers and [Client for Microsoft Networks] for the network clients, 
and click on [OK]  
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a.3 Network protocol 

The network protocol determines how the computers will communicate in the 
network. There are a variety of protocols, but the TCP/IP will be adopted for this 
network. To configure the protocol, follow the steps below.  

1. In the [Network] dialog box click [Add].  
2. In the [Select Network Component Type] dialog box, select [Protocol] and 

click on [Add].  

 
3. In the [Select Network Protocol] dialog box, choose [Microsoft] in the 

manufacturing type and [TCP/IP] in Network Protocols, then click on [OK]  
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a.4 Network services 

The network services determine which services will be shared. A network service 
should be installed if files and printers are to be shared. For configuration, follow the 
steps shown below.  

1. In the [Network] dialog box, click on [Add].  
2. In the [Select Network Component Type] dialog box, select [Service] and 

click on [Add].  

3. In the [Select Network Service] dialog box, select [File and printer sharing for 
Microsoft Networks] and click on [OK]  

 
b. Configuration of the network components 

After installing all components, you will need to configure the following components 
to successfully establish connection to the Windows NT Server.  

b.1 Client for Microsoft networks 

To configure this component, follow the next steps.  

1. In the [Network] dialog box, select [Client for Microsoft Network] and then 
click on [Properties]. 

 

 

 



  
 
Guidelines for GIS Operation  JICA  

 47 

 
 

2. In the [Client for Microsoft Network Properties], click on [Log on to 
Windows NT domain] to enable this option, and in the [Windows NT 
domain], type the name of the domain of the Server, in this case “DOMAIN”, 
because it was configured this way.  

 
3. Click on “OK”, to finish the configuration.  
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b.2 Configuring the protocol TCP/IP 
To configure this component, follow the next steps. 

1. In the [Network] dialog box, select [TCP/IP] and click on [Properties]. 
2. In the [TCP/IP] dialog box, select the [IP Address] window. Click on [Specify 

an IP address], to enable this option and then type [IP address] and the 
[Subnet Mask].  

 

 
3. Each network should decide on an IP address. The IP address to be adopted 

for this network is as shown below:  
IP Address for workstations: 192.154.0.11 up to 192.154.0.99  

Subnet Mask: 255.255.255.0  

These addresses will be modified as the network grows.  
4. Click on [OK] to finish the configuration.  

b.3 Configuring the identification in the network 

It is necessary to configure the identification of the computer to avail of the network 
services. To do so, follow the steps below.  

1. In the [Network] dialog box, select the [Identification] window. In [Computer 
Name], type the name that will identify the Computer inside the network. In 
[Workgroup], type the same domain that is configured in the Server, in this 
case “DOMAIN”, and then type the description of the computer in [Computer 
Description].  
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2. Click on “OK”, and then restart the computer to activate all changes made.  

c. How to register in the Windows NT Network 

Once the components have been added and configured, the computer will restart. 
Thereafter, follow the steps below.  

1. When the computer starts, the registration dialog box will appear on screen.  
2. Before registering make sure that the Server is on, and the [Username] is 

registered in the network domain.  
3. In the registration dialog box, type the [User Name], the password [Password] 

and the domain of the Server [Domain], in this case “DOMAIN”.  
 

1.2.7 Administering the Windows NT Server 

This is part of the network administrator’s task; it is the administration who has 
access to the server. This task also forms the base of the system’s security. In fact, to 
grant access to a system is the first point of verification of any security plan. 
Windows NT includes an Administration of users with complete characteristics that it 
allows you to create and to administer users' account, the same as users' groups. 

a. Understanding the domains 
A domain is the main base of a Microsoft NT Network. Basically, a domain is a 
group of computers and related network resources. At least one of the computers 
should be Windows NT, but it could have many more servers in the domain. Because 
the domain is a logical organisation it doesn't have geographical limits. This means 
that a single domain could be in the same room, in the same building or disseminated 
all over the city or all over the world.  
 
If commonly used with Internet, a Microsoft network domain can be easily confused 
with a domain of the Internet. Although these can be parallel organisations of 
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computers, both are not exactly the same thing. In the world of Internet, the domain 
identifies the Internet from the rest of the world, as long as a Microsoft network 
domain is used strictly to handle users and the resources to those that users can have 
access.  
 
To establish a domain, at least one Windows NT Server is required. This system acts 
as the Primary Domain Controller (PDC), and as the place that holds all the 
information related with the users and the resources for the domain.  

b. Understanding the users and groups 

Inside a domain of the Windows NT network, the following four specific elements 
are available:  

• Servers: This refers to the computers that are executed under the Windows 
NT Server and that make information and resources available for the domain.  

• Workstations: These are the computers that, through the execution of a 
variety of operating systems, gain access to, or in some cases provide, 
information that is available in the network.  

• Users: These are individuals that are entitled to use the workstations or the 
Servers in order to have access to the resources in the net. The access of 
general users is limited. The users are assigned an account and each obtains a 
name and a password that serve as an identification in order to access the 
network.  

• Groups: These are combined users. Through categorisation, groups of users 
simplify user administration. The account of the individual users can be 
assigned to different user groups. When belonging to a user group, 
automatically the account has access to certain data and resources in the 
network.  

c. Administering the user manager for domain 

One of the responsibilities of the network administrator is to establish directives for 
the account. To administer the user account, the [User Manager for Domain] is the 
tool to be used.  

1. Select [Program] in the [Start] menu. 
 

 
 

2. Select [Administrative Tools (Common)], and then [User Manager for 
Domain]. This will prompt the next dialog box [User manager-Domain].  
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d. Administering User Account 

One of the challenging tasks of a network administrator is maintaining a precise and 
up-to-date database of users. This task is very important in terms of security and the 
database should be constantly updated to facilitate administration.  

1. Select [Programs], in the [Start] menu, and select [Administrative Tools 
Common]. 

2. In the [User Manager-Domain] window, select [New User] in the [User] 
menu. This will prompt the [New user] dialog box, where the addition of a 
new user is typed in. 

 
 

Adding a new user account does not require a lot of information. The minimum 
requirement is a [Username], password [Password]; the latter will be confirmed in the 
[Confirm Password] section. Other information may be added as well.  
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Users Must Change Password at Next Logon. If this option is selected, the 
user must modify his password when he registers for the first time in the 
network. This means that the password that is provided in the dialogue box of  
[New User] is temporary, effective only when registering for the first time. 
For security purposes this option should be selected.  

User Cannot Change Password. If this option is selected the user won't be 
able to change his own password. If the password expires, it will be changed 
by the administrator.  

Password Never Expires. If this option is selected the user will never need to 
change his/her password.  

Account Disable. This option can be used to temporarily disable an account. 
This option is automatically selected if the user has been designated 
temporarilly and if the account has expired.  

 
3. In the lower part of the dialog box of [New User] are some buttons that allow 

the designation of additional information into the account.  
 

4. After specifying the user's information, click on [Add] to add a new user.  

e. Administering user groups 

Grouping users facilitates user management and gives the users within the group the 
rights designated to the group that they belong to. The following are the three main 
groups used in the Windows NT Server. 

• Local Groups: Are used to assign permission for the use of the local domain. 
This can contain users and Global groups, including Global groups from other 
trusted domains.  

• Global Groups: Contains user accounts only. This is used to export user 
accounts to other domains, where they can be imported into Local Groups on 
trusting domains  

• Special Groups: Used by Windows NT Server for system access, and do not 
contain user or group accounts. 

e.1 Global groups 
Global groups contain users from the local domain. They are also used to export users 
to another trusting domain. Global groups do not have rights to perform any 
administrative tasks. For instance, the built-in global group, Domain Admins, can 
only perform administrative tasks if it is made a member of the local group 
Administrators.  

(1) The built-in global groups 
The following table lists the Global groups built-in the Windows NT Server. 
 Global Group 
Name Members  Who can modify? Initially a member 

of  
Domain 
Administrator Administrator Administrators Administrators 

Domain Guests Guest Administrators  
Account Operators Guests 

Domain Users Administrator Administrators  
Account Operators  Users 
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(2) How to use groups in domains 

Let's consider some recommendations concerning the use of Global and Local group 
memberships as outlined by Microsoft.  
 
Function Group to use  
Export users to another domain Global  
Assign permissions and rights to local domain resources  Local 
Give rights to users from another domain Local 
Combine groups Local 
users need access to Windows NT Workstations or NT servers in a 
domain  Global 

 
(3) Add global groups 

1. To add a new group of users, simply select the option in the menu [Users] in 
the dialog box [User Manager Domain].  

2. If there is a need to add a global group, select [New Global Group].  
3. To define the global group, simply provide a name for the group and an 

optional description, then select the account of users that you want as member 
of the group.  

4. To add members, select the user's name in the list [Not Members], and then 
click on Add.  

5. After the group has been defined, click on [OK]. The new global group will 
appear in the inferior part of the [User manager].  

 
e.2 Local groups 

Local groups are limited to the domain [or computer] they are created on. They are 
created using User Manager, and a number of pre-existing Local groups have been 
provided.  

Local groups created on a Windows NT Server [non BDC or PDC] or Windows NT 
workstation are limited to that computer only. In contrast, a Local group created on a 
domain controller can be used on any server, which is a member of that domain, but 
cannot be used outside the domain.  

(1) Built-in local groups 

Microsoft recommends that you use the existing Local groups where possible. The 
following table lists the Local groups built-in the Windows NT Server.  
 
Available on    Local Group Name    Members     Who can modify?    Rights  
DC Account Operators 

(AO) 
None  Administrators  

Account Operators  
Server Operators  

Create, Delete, Modify user accounts and 
groups.  
Cannot modify the Administrator or Server 
Operator groups  

W+S+DC Administrators (AD) Domain   
Administrator 

Administrators  Create, Delete, Manage user accounts and 
groups.  
Share directories and printers.  
Grant resource permissions.  
Install OS files and programs.  

W+S+DC Backup Operators (BO) None Administrators Backup and Restore servers.  
Logon locally.  
Shut down the server.  

W+S+DC Guests (G) Guest  Administrators  
Account Operators 

  



  
 
Guidelines for GIS Operation  JICA  

 54 

W+S Power Users       
DC Print Operators (PO) None  Administrators Share and remove sharing printers.  

Manage printers.  
Logon locally.  
Shut down servers.  

W+S+DC Replicator None  Administrators  
Account Operators  
Server Operators  

Used with the Directory Replication Service.  

DC Server Operators (SO) None  Administrators Share and remove sharing resources.  
Format the server disks.  
Logon locally.  
Backup and restore servers.  
Shut down servers.  
Lock and unlock servers.  

W+S+DC Users (U) Domain Users  Administrators  
Account Operators 

  

Note: 
W = NT Workstation 
S = Windows NT Server 
DC = Domain Controller 

(2) Default rights for built-in local groups on Windows NT Server 

The following rights are visible in User Manager for Domains.  
 

Rights    AD    AO    BO    E    G    PO    SO    U    
Access this computer from the network Yes      Yes         
Backup Files and directories Yes   Yes       Yes   
Change the system time Yes           Yes   
Force shutdown from remote location Yes           Yes   
Log-on locally Yes Yes Yes     Yes Yes   
Manage auditing and security log Yes               
Shut down the system Yes Yes Yes     Yes Yes   
Restore files and directories Yes   Yes       Yes   
Take ownership of files Yes               
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The following rights are NOT visible in User Manager for Domains [defaults which 
you cannot change].  
 

Rights    AD    AO    BO    E    G    PO    SO    U    
Assign user rights Yes               
Create and manage user accounts Yes Yes             
Create and manage global groups Yes Yes             
Create and manage local groups Yes Yes           Yes 
Create common groups Yes           Yes   
Format the servers hard disk Yes           Yes   
Keep local profile Yes Yes Yes     Yes Yes   
Lock the server Yes     Yes     Yes   
Share and stop sharing directories Yes           Yes   
Share and stop sharing printers Yes         Yes Yes   
Unlock the server lock Yes           Yes   
 
Unlocking a server that has been locked by another user would lead to the loss of any 
work in progress. Users will only be able to add local groups if they have access to 
the User manager for Domains. Everyone has the right to lock an NT Server, but does 
not have the right to logon locally. 

(3) Add a local group 

1. To add a local group of users, select (File, New, Local Group).  
2. The information that aids the creation of a local group is almost the same as 

the one used to create a global group. The difference lies in the manner the 
group is formed.  

3. When initial members are added to the first local group, click on [Add] and 
then the [User Manager]. This would show the new dialog box that contains 
the list of all the global groups and users' account in the system.  

4. The local groups allow you to define a global group as members. To add the 
members, simply select the names in the superior part of the dialog box and 
then click on [Add].  

5. Click on [OK] and the names specified are added to the new local group as 
initial members.  

6. After the local group has been defined, click on [OK].  

f. Sharing files and folders 

1. Creating a share under Windows NT is quite easy. Simply find the folder you 
want to share, right-click on the folder and select the menu option labeled 
"Sharing". 
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2. A dialog box will pop up with a tab entitled "Sharing". This is the exact same 

panel that comes up if you right-click on a folder and select "Properties" - the 
only difference is that the "Sharing" tab is pre-selected for you. Click on the 
"Shared As" radio button. The "Share Name" field will automatically be 
filled in with the same name as the folder; it is possible however to change 
the name. 

f.1 Share and permissions 

Many Windows NT administrators are very confused about how share permissions 
work. The basic problem is that there are two types of permissions involved - share 
and file permissions. Below are their definitions: 

• Share Permissions: These are the permissions for who is allowed to connect 
to that share, and what they are allowed to do in that share (i.e., only read 
files, change files, create and delete files, etc.). Share permissions only apply 
when connecting to shares over a network. Shares are not used at all when 
connecting to files on the computer you are currently on (Microsoft calls this 
"logged on locally").  

• File Permissions: These are Windows NT security file permissions, which 
apply to files at all times (whether connecting remotely or locally). These 
permissions specify who can access that file or folder, and what they can do to 
it (i.e., only read files, change files, create and delete files, etc.). To set these 
permissions, you must be using NTFS. If the drive/partition is formatted as 
FAT, file permissions cannot be set. 

 
When a person attempts to connect to a share to read a file, NT does the following 
(and denies access if any check fails): 

• Checks to see if that user has permission to connect to the share  
• Checks to see if that user has read access to the share  
• Checks to see if that user has file permissions to that file in the share  
• Checks to see if that user has read access to that file in the share  
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As you can see, a lot of checks are done. Basically, Windows NT is going to apply 
the most-restrictive rules when granting access to files. 

By default, when you create a share, Windows NT sets the share permissions to 
"Everyone/Full Control". Go back into the Sharing properties of the share created 
previously, and this time click on the "Permissions" button. It should look like this: 
 

 
 
This is called default "pass through share security", because it is simply letting 
anyone on your network connect to this share (whether in your domain or not!), and 
granting them full control over the files there. Remember, though, that if you are 
using NTFS, they must also have file-level permissions to really access the files. 

If you are familiar with file-level permissions (and you certainly should be), you'll 
notice that this panel is nearly identical to the one used for setting file-level 
permissions. Using it, you can define who is allowed to access this share. 
 
Examples. 
For example, say you have a folder named "test1" with three files in it, FILE1, 
FILE2, and FILE3. You set up a share granting EVERYONE full control. However, 
on each file you set it to be full control for administrators, and No Access for domain 
users. What happens when a user connects to that share? They can connect, and see 
the file names, but attempts to do anything result in an 'access denied' on the file. 
 
If you change FILE2 to be full control by everyone, you allow anyone to use it - but 
not files FILE1 and FILE3. This works the other way around, too. Assuming that you 
set all three files to Full Control by Everyone via file permissions. You then change 
the SHARE permissions to only allow Read access by Domain Administrators (no 
other access). Here's what would happen: 
 

• Domain administrators can connect to the share. When connected to the share, 
they can ONLY read the files. (Note that if they log on locally to the system, 
they don't need to use a share, and they have Full Control) 
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• Domain users can't connect to the share at all. Like Domain Administrator, 
they have full control over the files IF they are logged on locally to the 
computer, since the files are set as Full Control. 

 

g. Sharing printers 

1. Select [Setting] from the [Start] menu, then select [Printer]. 
 

 
 

2. In the [Printer] folder, select the printer to use in the LAN, click the right 
mouse button, and then select [Properties]. 
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3. In the printer [Properties] dialog box, select the [Shared as] option and type 

the [Share Name], and then click [OK] 
4. Now this printer is available for all in the LAN. 
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